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Overview
BattleStar 2000 is a small game similar to the classic BattleShip. The BattleStar game board is a 9x9x9 grid representing a 3-D 
galaxy. The galaxy contains 972 sectors, 60 of which contain enemy warships. You must locate and destroy these enemy 
invaders before they can establish bases in the galaxy.

BattleStar 2000 is fully Y2K compliant and will work with MS Windows XP and Millenium Editions as well as Windows 9x/NT and
Windows 2000 systems.

Game Play
Simply click the Mouse on any galaxy sector coordinate to select a missile target and then press the Spacebar to fire a missile. 
Press the Enter key to move to the next galaxy quadrant.

Purchasing BattleStar
BattleStar 2000 is a fully functioning program. It is not crippled in any way.

BattleStar 2000 is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days you are required to 
register it. If after evaluating BattleStar for 30 days you decide not to register it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and support via E-Mail or telephone.

You may also purchase BattleStar 2000 using your credit card via the Internet or by telephone.

Desktop Locations
BattleStar’s location on the desktop is saved when the program is exited. Whenever you start BattleStar it will reappear on the 
desktop where you last placed it. BattleStar property sheet locations are also stored and reused the next time they are opened.



Installing BattleStar
Installation
To install BattleStar 2000 on your computer simply create a new, empty folder and place the files; BSTAR.EXE, BSTAR.HLP and
BSTAR.CNT there.

BSTAR.EXE - The BattleStar Application
BSTAR.HLP - The Windows 95/NT Help File
BSTAR.CNT - The Windows 95/NT Help Contents File

If you installed BattleStar 2000 using the SETUP.EXE program and selected the default installation settings BattleStar 2000 will 
be installed in the C:\Program Files\Software by Design folder.

To integrate BattleStar 2000 with the MS Windows Explorer select the Help | Setup menu item to open the BattleStar Explorer 
Setup property sheet.

Note If you have an earlier version of BattleStar 2000 installed on your computer, simply replace the BSTAR.EXE, BSTAR.HLP 
and BSTAR.CNT files with the newer versions.

The various application settings specified in the BattleStar Options property sheet as well as the main window’s size and 
location on the desktop are stored in the MS Windows 95/NT System Registry.

Warning If you rename the BSTAR.EXE file you must also rename the BSTAR.HLP file using the same basename. For example
if you change the BattleStar application file name to NewName.exe, rename the help file to NewName.hlp. Do not rename the 
BSTAR.CNT file however. The HLP and CNT files must reside in the same folder as the BattleStar application file itself.

The MS Windows 95/NT Help program creates a pair of files associated with the BSTAR.HLP file. These files will have file 
extensions of GID and FTS. These files are used to store specific information about the help window location on the desktop and
the word list used for topic searching. These two files will be created when the BattleStar 2000 Help file is first used.



Configuring BattleStar
BattleStar Options
Select the File | Options menu item to open the BattleStar Options property sheet. This window will allow you to change the 
various BattleStar program settings listed below.

Easy
Check this item to play BattleStar games that are VERY easy to win. You will be given 360 Missiles and 150 Fuel Units.

Normal
Check this item to play BattleStar games that are challenging. You will be given 240 Missiles and 100 Fuel Units.

Hard
Check this item to play BattleStar games that are VERY hard to win. You will be given 120 Missiles and 50 Fuel Units.

Play Sound F/X Wave Files
Check this box to play WAV files. Your computer system must be equipped for MultiMedia and have a sound card installed for 
this option to be valid.

OK
Press this button when you have completed your selection of BattleStar program options. When you press this button the 
BattleStar Options property sheet will be closed and your settings will be saved.

Cancel
Press this button to close the BattleStar Options property sheet without making any changes. If you have made any changes 
to the option settings, and then press this button your changes will not be used, and your previous settings will remain in use.

Help
Press this button to open the BattleStar Help Window and go directly to the Configuring BattleStar topic.

Note The options you have selected will be saved when you press the OK button. The desktop location of the BattleStar Options
window itself will also be stored. Your settings will be saved in the MS Windows 95/NT System Registry.



BattleStar Explorer Setup
BattleStar Explorer Setup
Select the File | Options menu item to open the BattleStar Options property sheet. Select the Explorer tab to display MS 
Windows 95/NT Explorer setup options. This window will allow you to integrate BattleStar 2000 with the Microsoft Windows 
95/NT Explorer. You can also select the Help | Setup menu item to go directly to this window. Use this command to create and 
remove MS Explorer shortcuts for BattleStar 2000.

Create a Start Menu Item
Check this item to create a BattleStar Start Menu entry. The BattleStar 2000 program will be located in the Software by 
Design folder on the Programs menu. This item will be disabled (grayed) if a BattleStar item already exists in the Software by 
Design folder.

Remove this Start Menu Item
Check this item to remove the BattleStar entry located in the Software by Design folder on the Programs menu. This item will 
be disabled (grayed) if a BattleStar item does not already exist in the Software by Design folder.

Create a Desktop Icon
Check this item to create a BattleStar 2000 program icon on the Explorer desktop. This item will be disabled (grayed) if a 
BattleStar desktop icon already exists.

Remove Icon from the Desktop
Check this item to remove the BattleStar 2000 program icon from the Explorer desktop. This item will be disabled (grayed) if a
BattleStar desktop icon does not already exist.

Create a Startup Folder Item
Check this item to automatically run BattleStar 2000 whenever Microsoft Windows is started. This option creates a BattleStar 
program icon in the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a BattleStar startup item 
already exists in the Startup folder.

Remove the Startup Folder Item
Check this item to remove BattleStar from the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a 
BattleStar startup item does not already exist in the Startup folder.

OK
Press this button when you have completed your selection of MS Explorer shortcuts. When you press this button the 
BattleStar Setup property sheet will be closed and the MS Explorer shortcuts you have selected will be created or removed.

Cancel
Press this button to close the BattleStar Explorer Setup property sheet without creating or removing any MS Explorer 
shortcuts.

Help
Press this button to open the BattleStar Help window and go directly to the BattleStar Explorer Setup topic.



Game Menu
Game Menu Commands
The Game menu provides commands to play and save BattleStar games. A short description of each item follows:

New
Starts a new BattleStar game. The Ctrl+N shortcut can be used for this command.

Open
Opens a previously saved BattleStar game document, and loads it for play. When this item is selected the standard MS 
Windows Explorer file browser will be displayed, use this window to select the game you wish to resume playing. The 
Ctrl+O shortcut can be used for this command.

Properties
Display file property information about the current BattleStar game document. The Alt+Enter shortcut can be used for this 
command.

Close
Closes the currently active BattleStar game. You will be prompted to save or discard the current game before closing. The 
Ctrl+W shortcut can be used for this command.

Save
Saves the current game. The Ctrl+S shortcut can be used for this command.

Options
Opens the BattleStar Options property sheet and allows you to change BattleStar program settings. Use this command to 
configure the BattleStar program.

Exit
Closes the BattleStar 2000 program and returns control to the Explorer desktop. The Ctrl+Q shortcut can be used for this 
command.

Tip Commonly used Game commands can be invoked using shortcut keys.



View Menu
View Menu Commands
The View menu provides commands used to change BattleStar display options. These items provide a means of changing the 
BattleStar window appearance. A short description of each item follows:

Z Axis Scan
Use this command to display a Z Axis Scan of the galaxy. The Ctrl+Z shortcut can also be used for this command.

Y Axis Scan
Use this command to display a Z Axis Scan of the galaxy. The Ctrl+Y shortcut can also be used for this command.

X Axis Scan
Use this command to display a Z Axis Scan of the galaxy. The Ctrl+X shortcut can also be used for this command.

Scanner Log
Use this command to display the BattleStar Scanner Log window. This window will contain information regarding the galaxy
coordinates you have explored. The Ctrl+L shortcut can also be used for this command.

Always on Top
Use this command to keep the BattleStar window top most on the desktop. When this item is checked the BattleStar 
window will float above all other non-topmost windows on the desktop. This item is useful if you normally run BattleStar with
a small window that would be easily obscured by other applications. The Ctrl+T shortcut can be used for this command.

Tip Commonly used View commands can be invoked using shortcut keys.



Ship Menu
Ship Menu Commands
The Ship menu provides commands used to control the ship. A short description of each item follows:

Aim
Opens and displays the targeting coordinate window. The Ctrl+A shortcut can also be used for this command.

Fire
Fires a single missile using the current target coordinates. The Ctrl+F shortcut can also be used for this command.

Helm
Opens and displays the helm coordinate window. The Ctrl+H shortcut can also be used for this command.

Engage
Engages the engines. The Ctrl+M shortcut can also be used for this command.

Reverse
Reverses the engines. The Ctrl+R shortcut can also be used for this command.

Play Sounds
This command turns sounds F/X on and off. The Ctrl+P shortcut can also be used for this command.

Tip Commonly used Ship commands can be invoked using shortcut keys.



Help Menu
Help Menu Commands
The Help menu provides commands used to get help with BattleStar operations. A short description of each item follows:

Contents
Opens the BattleStar Help Topics window and displays the Table of Contents. The F1 shortcut can be used for this 
command.

Search
Opens BattleStar Help Topics and displays the Search window. You can use this window to search for specific BattleStar 
help topics.

How to Use Help
Opens a Help window that explains how to use the MS Windows 95/NT Help program.

Game Rules
Displays BattleStar game rules. Press the [Esc] key, or click your mouse anywhere in the main viewing region to resume 
play.

Keyboard Shortcuts
Displays BattleStar keyboard shortcuts. Press the [Esc] key, or click your mouse anywhere in the main viewing region to 
resume play.

Mission Orders
Displays BattleStar mission orders. Press the [Esc] key, or click your mouse anywhere in the main viewing region to 
resume play.

Register
Displays the BattleStar Shareware Registration Wizard. This wizard allows you to register    BattleStar 2000 for authorized 
use.

Setup
Displays the BattleStar Explorer Setup property sheet. This window provides options to integrate BattleStar 2000 with the 
MS Windows Explorer. Use this window to create MS Explorer Start Menu items and desktop icons.

Web Site
Opens your web browser application and goes directly to the Software Design web site on the Internet.

Send E-Mail to Author
Opens your Internet eMail client application and allows you to send an eMail message directly to the author at 
Support@GregoryBraun.com.

Note You must have your Internet eMail client software configured as your default Simple MAPI client for this command to 
work properly

About BattleStar
Displays the BattleStar splash box. This window contains program information, the current version of BattleStar you are 
running and a program copyright notice. Click the mouse anywhere in this window to close it

Tip Commonly used Help commands can be invoked using shortcut keys.



Shortcut Keys
Shortcuts
Shortcut keys allow you to quickly invoke BattleStar menu commands without first displaying the menu and then selecting an 
item from it. The most commonly used BattleStar commands can be invoked using the following shortcut keys.

Game Menu
Ctrl+N Start a new BattleStar game
Ctrl+O Open an existing BattleStar game
Alt+Enter Display BattleStar document properties
Ctrl+W Close the current BattleStar game
Ctrl+S Save the current BattleStar game
Ctrl+Q Exit BattleStar, and return to the desktop

View Menu
Ctrl+Z View along the Z axis
Ctrl+Y View along the Y axis
Ctrl+X View along the X axis
Ctrl+L Open the Scanner Log
Ctrl+T Make the BattleStar window topmost

Ship Menu
Ctrl+A Set targeting coordinates
Ctrl+F Fire a missile
Ctrl+H Set helm coordinates
Ctrl+M Engage the engines
Ctrl+R Reverse the engines
Ctrl+P Turn sound F/X on and off

Help Menu
F1 Display this Help file

Keyboard Shortcuts
The following keyboard shortcuts can also be used. These commands do not require the Ctrl or Alt key, but rather can be issued 
directly from the keyboard:

Weapons
A Aim Dialog
F File Missile

Engines
H Helm Coordinates
E Engage Engines
R Reverse Engines

Scanner
X Axis Scan
Y Axis Scan
Z Axis Scan



Comments and Upgrades
Comments and Suggestions
If you have comments, questions or find any bugs in BattleStar 2000 please feel free to contact me via email.

Gregory Braun – Software Design

Email: Support@GregoryBraun.com
Web Site: http://www.gregorybraun.com
Phone: 1.414.817.6508

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.gregorybraun.com)



Release History
BattleStar 2000 Release History

v2.0 Original in-house development and testing of MS Windows 95/NT conversion using the Microsoft Win32 SDK.

v2.1 Added 95/NT splash box for release.

v2.2 Added facilities to save Aiming, Helm and Scanner Log dialog box desktop locations in the INI file. 

v2.3 Added support for screen color settings as specified in the Display Properties dialog. Added default user and company 
name to the splash box.

v2.4 Added an MS Windows 95/NT Help file. BattleStar program settings are now saved in the MS Windows 95/NT System 
Registry. Fixed a bug that prevented proper window repositioning when the MS Explorer Taskbar was placed on the left 
edge or at the top of the desktop. Converted the BattleStar Options dialog box to a three-tab property sheet. Added an 
automated Explorer Setup facility. Added a BattleStar Diagnostics explanation. Fixed several other minor bugs.

v2.5 Fixed several minor bugs.

v2.6 Added support for MS Windows 98 systems. Fixed several minor bugs.

v2.7 Fixed several minor bugs.

v2.8 Fixed several minor bugs.

v2.9 Fixed several minor bugs.

v3.0 Adds support for MS Windows Millenium Edition and Windows 2000. Fixed several minor bugs.

v3.1 Adds support for MS Windows XP systems. Fixes several minor bugs.

v3.2 Fixes several minor bugs. This is a maintenance release.

Last Update  April 17th, 2002

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.gregorybraun.com)



System Registry
BattleStar 2000 System Registry Key
BattleStar 2000 stores configuration settings in the MS Windows 95/NT System Registry. These settings are updated 
automatically while BattleStar is running. There is no need to edit these settings manually.

If you insist upon editing these settings, you do so at your own risk. BattleStar automatically updates registry entries when it 
exits. If you edit these settings make sure BattleStar is not running while you edit them. If BattleStar is currently running your 
changes will be overwritten when BattleStar exits.

BattleStar 2000 stores configuration settings in the following system registry key:

HKEY_CURRENT_USER
Software

Software by Design
BattleStar for Windows 95/NT

Section
Label = Value

Warning There is no need to edit these settings manually. BattleStar will automatically maintain these settings for you. If you do 
edit these, you do so at your own risk.



Removing BattleStar
Removing BattleStar 2000
If you find that BattleStar 2000 does not meet your needs you can remove it from your computer system by simply deleting the 
following files from your hard drive.

All of these files will be located in the folder that you originally installed BattleStar in.

The default location for all BattleStar 2000 program files is the C:\Program Files\Software by Design folder. Unless you 
specified a different folder when you ran SETUP.EXE you will find the BattleStar files here.

BStar.exe BattleStar 2000 program.
BStar.cnt BattleStar Help Topics File
BStar.hlp BattleStar Help File

If you have opened and used the BattleStar 2000 Help files your system may contain the following two (2) files. These files are 
created by the standard MS Windows 95/NT Help program WinHlp32.exe. These files may also be safely removed.

BStar.gid MS Windows Help settings file. This file contains the BattleStar Help window size and desktop location as 
well as any bookmarks you may have created.

BStar.fts MS Windows Help word database. This file is created when you build a custom word list for BattleStar Help 
files. This file is used to search for words and phrases in the BattleStar Help files.

BattleStar 2000 does not use any custom DLL files or system drivers. If you delete the files mentioned above from your system’s
hard drive you will have completely removed BattleStar from your computer system.

Note If you have installed BattleStar shortcuts on the MS Explorer Start Menu use the Help | Setup command to remove the 
shortcuts you created before you delete the BattleStar files mentioned above.



Software Design Web Site
Software Design
You can download the latest versions of all of my software from my web site on the Internet. I post the latest releases of my 
software there first. Click your mouse on the link listed below to visit the Software Design web site.

Software Design Web Site

(http://www.gregorybraun.com)

Software Titles
The following software titles are available at my web site on the Internet and can also be found on CompuServe, ExecPC, MSN 
and ZD Net.

AppPaths 2000 (APPPATHS.ZIP)
Audition 2000 (AUDITION.ZIP)
BattleStar 2000 (BSTAR32.ZIP)
BattleStar for Windows (BSTAR.ZIP)
BlowFish 2000 (BLOWFISH.ZIP)
Calendar 2000 (CALENDAR.ZIP)
CardBase 2000 (CARDBASE.ZIP)
Crypto 2000 (CRYPTO.ZIP)
Disk CleanUp 2000 (CLEANUP.ZIP)
DLL Show 2000 (DLLSHOW.ZIP)
File Editor 2000 (FXEDIT32.ZIP)
File Editor for Windows (FXEDIT.ZIP)
File Shredder 2000 (SHREDDER.ZIP)
FontShow 2000 (FONTSHOW.ZIP)
Icon Extractor 2000 (ICONX32.ZIP)
Icon Extractor for Windows (ICONX.ZIP)
Kart Data 2000 (KARTDATA.ZIP)
Lap Timer 2000 (LAPTIMER.ZIP)
MIRV 2000 (MIRV2000.ZIP)
MS Windows Error Messages (MSWINERR.ZIP)
NoteBook 2000 (NBOOK32.ZIP)
NoteBook for Windows (NBOOK.ZIP)
Password Keeper 2000 (PASSKEEP.ZIP)
Phantom Desktop Screen Saver (PHANTOM.ZIP)
Programmer's IDE 2000 (PMAN32.ZIP)
Programmer's IDE (PMAN.ZIP)
Reminders 2000 (REMIND32.ZIP)
Reminders for Windows (REMIND.ZIP)
RGB Editor 2000 (RGB32.ZIP)
RGB Editor for Windows (RGB.ZIP)
Screen Loupe for Macintosh (LOUPE.SEA)
Screen Loupe for Windows (LOUPE.ZIP)
Screen Loupe 2000 (LOUPE32.ZIP)
Slot Cars 2000 (SLOTCARS.ZIP)
Stay Live 2000 (STAYLIVE.ZIP)
Submit It 2000 (SUBMITIT.ZIP)
ToolBar for Windows (TBAR.ZIP)
ToolBar 2000 (TBAR32.ZIP)
Touch for Windows (WTOUCH.ZIP)
Tray Tools 2000 (TRAYTOOL.ZIP)
TxEdit 2000 (TXEDIT.ZIP)
Unit Conversions 2000 (UCONVERT.ZIP)
WebTime 2000 (WEBTIME.ZIP)
World Radio for Macintosh (WRADIO.SEA)

Note The latest versions of my software programs are always posted on my web site first. Versions found on the other online 
services may be earlier releases.



BBS and Internet Operators
Webmasters
Please upload the original ZIP file intact and title the submission:

"BattleStar 2000 v3.2"
--Author Gregory Braun

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.gregorybraun.com)

Note This site also supports anonymous FTP transfers.



BattleStar Diagnostics
BattleStar Diagnostics
During the development of BattleStar 2000 a diagnostics facility was needed to test various game scenarios. These diagnostics 
commands remain in the release version. These commands are included for testing purposes only and should not be used by 
regular game players.

D Toggles BattleStar diagnostics ON and OFF

E Selects Engines for update
Arrow Keys To increase and decrease the Fuel supply

W Selects Weapons for update
Arrow Keys To increase and decrease the Missile supply

S Turns the BattleStar Scanner ON and OFF



What is Shareware
The concept of "Shareware"...
Shareware, also known as user supported software and other names, is a concept not understood by everyone. The author of 
Shareware retains all rights to the software under the copyright laws while still allowing free distribution. This gives the user the 
chance to freely obtain and try out software to see if it fits their needs. Shareware should not be confused with Public Domain 
software even though they are often obtained from the same sources.

If you continue to use Shareware after trying it out, you are expected to register your use with the author and pay a registration 
fee. What you get in return depends on the author, but may include a printed manual, free updates, telephone support, etc. Only 
by paying for the Shareware you use do you enable the Shareware author to continue to support his software and create new 
programs. Considering that the Shareware registration fees are almost always far less than the purchase price of comparable 
commercial software it's obvious that Shareware is a good deal for everyone.

There are real advantages to you in the Shareware system. You get to try out software to make sure it is compatible with your 
hardware and that it fits your needs before you "buy" it with your registration. The author saves the expense of advertising, 
packaging and distribution and passes the savings on to you. Plus, most Shareware authors are much more accessible than 
commercial software sources so that your questions and suggestions are much more likely to be responded to.

Thank you for your support.



Registering BattleStar 2000
Registering BattleStar
BattleStar 2000 is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days you are required to 
register it. If after evaluating BattleStar for 30 days you decide not to register it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and telephone support.

You can register BattleStar 2000 by mailing the Order Form provided with this software. When you register BattleStar 2000 you 
will receive your registration code by E-Mail, or optionally you may request that your registration code be mailed to you.

You may also purchase BattleStar 2000 using your credit card via the Internet or by telephone.

The software you are currently using is a fully functioning program. As a registered user you will however be able to disable the 
initial splash box that appears when BattleStar 2000 is first launched.

To register your copy of BattleStar 2000 select the Help | Register menu command. The Shareware Registration Wizard will be 
displayed when this menu command is selected. Use this window to fill in the following entry fields:

User Name
Enter the user name you originally specified when you ordered BattleStar 2000.

Organization
Enter the name of your organization as originally specified when you ordered BattleStar 2000. If you did not specify an 
organization name leave this field blank.

Registration
Enter the registration code that was provided to you. Enter your registration code exactly as provided. Do not include spaces 
when entering your registration code.

Note The registration code was provided to you when you purchased BattleStar 2000. Refer to the notification letter that was 
mailed to you or the E-Mail message you received for your personal shareware registration code.

Show Splash Box at Startup
This box will be initially checked if you have not registered BattleStar 2000. When you successfully register your copy of 
BattleStar this box will automatically be unchecked for you. If you wish to see the splash box when BattleStar is launched 
return to this Registration Wizard and check this box.

OK
Press this button after you have filled out the Shareware Registration Wizard to complete BattleStar 2000 shareware 
registration.

Cancel
Press this button to close the Shareware Registration Wizard    without making any changes.

Help
Press this button to open the BattleStar Help window and go directly to the Registering BattleStar topic.



Purchasing Information
Purchasing Information
BattleStar 2000 is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days you are required to 
register it. If after evaluating BattleStar for 30 days you decide not to purchase it you are required to remove it from your 
computer.

Registration entitles you to unlimited free updates and telephone support.

You can register BattleStar 2000 by mailing the Order Form provided with this software. When you register BattleStar 2000 you 
will receive your registration code by E-Mail, or optionally you may request that your registration code be mailed to you.

You may also purchase BattleStar 2000 using your credit card via the Internet or by telephone.

The software you are currently using is a fully functioning program. As a registered user you will however be able to disable the 
initial splash box that appears when BattleStar 2000 is first launched.

Single User Licensing
Individual users can register BattleStar 2000 for $25.00 dollars. If you would also like a 3 ½” floppy disk sent to you please add 
an additional $5.00 dollars. Registration entitles you to unlimited free updates and telephone support. You can always download 
the latest release of BattleStar directly from the Software Design web site on the Internet. Print the BattleStar 2000 Order Form 
and mail it with your check to become a registered user of BattleStar 2000.

Site Licensing
BattleStar 2000 can also be registered for use at an entire site for $250.00 dollars. If you would like to install and use BattleStar 
on multiple workstations at a single location choose this type of licensing. Registration includes a 3 ½” floppy disk and entitles 
you to unlimited free updates and telephone support. You can always download the latest release of BattleStar directly from the 
Software Design web site on the Internet. Print the BattleStar 2000 Order Form and mail it with your check to become a 
registered user of BattleStar 2000.

Corporate Licensing
BattleStar 2000 can also be registered for use at multiple sites for $1000.00 dollars. If you would like to install and use BattleStar
on multiple workstations at multiple locations choose this type of licensing. Registration includes a 3 ½” floppy disk and entitles 
you to unlimited free updates and telephone support. You can always download the latest release of BattleStar directly from the 
Software Design web site on the Internet. Print the BattleStar 2000 Order Form and mail it with your check to become a 
registered user of BattleStar 2000.



BattleStar 2000 Order Form
To print this order form, press the Print button above, or select Print Topic from the File pull-down menu.

Secure on-line credit card orders can be placed from the Software Design web site.

To order by check, send this order form and a check to:

Gregory Braun
P.O. Box 1307
Milwaukee, WI    53201-1307 U.S.A.

Payments must be in US dollars drawn on a US bank, or you can send international postal orders in US dollars.

All orders are subject to the License Agreement.

Customer information is considered confidential and will not be shared or distributed to any third parties.

Registered users of BattleStar 2000 are entitled to unlimited free program updates.

Single User Copy ______ at $25.00 each = ________

Optional 3 ½” Disk ______ at $5.00 each = ________
Site License ______ at $250.00 each = ________

Includes 3 ½” Disk
Corporate License ______ at $1000.00 each = ________

Includes 3 ½” Disk

Wisconsin Residents add 5.5% sales tax: ________

Total Payment: ________

Date ____________________________________

Name ____________________________________

Organization ____________________________________

Shipping Address ____________________________________

____________________________________

City ____________________________________

State ____________________________________

Zip Code ____________________________________

Country ____________________________________

Day Phone ____________________________________

E-Mail Address ____________________________________
[    ] Please send registration code via E-Mail

Comments:





Credit Card Purchases
Credit Card Purchases
You may purchase BattleStar 2000 by credit card over the telephone or directly from my web site on the Internet.

On-line Registration
Secure on-line registration using a major credit card is available directly from the Software Design web site. Simply go to the 
BattleStar 2000 program description page and click your mouse on the RegNet link. You may register BattleStar 2000 using 
your Master Card, Visa, American Express, Discover or EuroCard. Registration keys will be sent to you via eMail.

Telephone Registration
You may also purchase BattleStar 2000 toll-free by telephone. Please specify BattleStar 2000 when ordering.

Toll-Free: 1.800.999.2734
International: 1.719.576.0123
FAX Line: 1.719.623.0399

RegNet Product Codes
2155 BattleStar Single User License

RegNet Pages
Single User http://www.reg.net/product.asp?ID=2155

Web Site
Click your mouse on the underlined link below to purchase BattleStar 2000 by credit card.

Software Design Web Site

(http://www.gregorybraun.com)



License Agreement
License Agreement

You should carefully read the following terms and conditions before using this software.    Unless you have a different license 
agreement signed by Gregory Braun, your use of this software indicates your acceptance of this license agreement and 
warranty.

Registered Version
One registered copy of BattleStar 2000 may either be used by a single person who uses the software personally on one or 
more computers, or installed on a single workstation used nonsimultaneously by multiple people, but not both.

Site License
Any number of users at a single location may access the registered version of BattleStar 2000 through a network, provided 
that you have obtained a site license for the software covering all workstations that will access the software through the 
network. Any number of users at a single location can install and use the software on one or more computers or workstations.

Corporate License
Any number of users at any number of locations may access the registered version of BattleStar 2000 through a network, 
provided that you have obtained a corporate license for the software covering all workstations that will access the software 
through the network. Any number of users at any number of locations can install and use the software on one or more 
computers or workstations.

Software Updates
Registered users of BattleStar 2000 are entitled to unlimited free program updates. Software updates can be downloaded 
directly from the Software Design web site on the Internet.

Governing Law
This agreement shall be governed by the laws of the State of Wisconsin.

Disclaimer of Warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT WARRANTIES AS TO 
PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED. NO 
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data before relying on it. The
user must assume the entire risk of using the program.    ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY 
TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.



Using the Help File
Using the Help File
The settings and commands described in this section apply to the BattleStar 2000 Help window, not the BattleStar 2000 
program itself.

Context Sensitive Help
Most BattleStar 2000 windows, property sheets and dialog boxes provide a Help button in the lower right-hand corner of the 
window. Pressing the Help button in any of these windows will open the BattleStar 2000 Help File and take you directly to that 
section of the Help File pertaining to the window currently in use.

Navigating the Help File
MS Windows Help Files include hyperlinks similar to those used by most Internet Web Browsers. Clicking your mouse on an 
underlined word or phrase will take you directly to that section of the Help File. Pressing the Back button at the top of the Help 
window will return you to the page you were previously viewing.

Browsing the Help File
You can also browse through all of the sections in the Help File by pressing the [ << ] and [ >> ] buttons displayed at the top of 
the Help window.

Printing the Help File
You can print individual pages of the Help file by pressing the Print button at the top of the Help window. Unfortunately Help 
topics must be printed one at a time. The MS Windows Help system does not provide a single command to print the entire Help 
file.

Searching the Help File
You may search the entire Help file for a specific word or phrase by pressing the Find button at the top of the Help window. The 
first time the Find tab is selected you will be prompted to build an index or words contained in the Help file. The Find command 
opens a second window with three tabs. Select the Find tab to search for a word or phrase. The Index tab can also be selected 
to search for commonly used topics and subjects.

Table of Contents
You can also view the entire Table of Contents for the Help file by pressing the Help Topics button at the top of the Help 
window. The Contents tab of the Help Topics window provides an easy means of viewing the entire Table of Contents arranged 
by section and topic.

Bookmarks
You can also create your own set of bookmarks for pages of the Help file that you refer to often. Use the Bookmark | Define 
menu command to add a new bookmark to the section of the Help file you are currently viewing or select a previously defined 
bookmark from the list to go directly to that section of the Help file.

Annotations
You can also create your own set of annotations for pages of the Help file that you refer to often. Use the Edit | Annotate menu 
command to add your own comments and notes about a specific page in the Help File. Annotated Help file pages will include a 
small paperclip graphic in the upper left-hand corner of the current page. Click your mouse on this small paperclip to display any
notes or comments you have recorded.

Customizing Help
The MS Windows Help File system can be customized to better suit your viewing needs and habits. See the Customizing Help 
section for more information about customization.



Customizing Help
Customizing Help
You can customize this help file to better suit your needs and uses. The following topics describe the various settings that can be
configured. The settings you specify will be saved and used again each time you view this help file.

Font Size
The size of the font used in this help file can be made larger or smaller by selecting the Font item from the Options menu 
above. Select Small, Normal or Large fonts from the popup menu. The font size you select will be saved and used again each 
time you view this help file.

Window Size
The size of this Help window and its location on the desktop can be adjusted using the standard Windows resizing and 
placement methods. The window size and its location on the desktop will be saved and used again each time you view this help 
file.

Window Background Color
The background color for this help window can be changed to white if you prefer. To change the background color to white select
the Use System Colors item from the Options menu above. For the color changes to take effect you will have to close and 
then reopen the Help file. You will be prompted to confirm this action. Your background color selection will be saved and used 
again each time you view this help file.

Window Placement
By default this help window positions itself in front of all other open windows. If you would prefer to have it covered up by other 
active windows select the Keep Help on Top item from the Options menu and then select Not on Top from the popup menu. 
Your selection will be saved and used again each time you view this help file.






